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MODIFY COMMAND 
 
Objectives    At the end of this chapter, you should be able to: 
 

 Locate and invoke the  Modify command 
 Erase objects from the drawing. 
 Move objects from a base point to a second point  

of a displacement. 
 Rotate objects about a basepoint. 
 Enlarge or reduce objects with scale. 
 Make mirror images of selected objects. 
 Make rectangular and polar arrays of existing objects 
 Stretch selected object. 
 Trim away parts of objects at cutting edges. 
 Extend objects to selected boundary edges. 
 Create a fillet between two objects. 
 Create a Chamfer between two objects. 
 Create parallel copies of objects with offset. 

 
                
INTRODUCTION 
 

Draw commands are used to create new objects. Modify commands or edit 
commands are used to change existing objects or to use existing objects to create new 
and similar objects. The commands listed below are covered in this unit: 

 
Erase 
Move 
Rotate 
Trim 
Scale 
Mirror 
Array 
Stretch 
Extend 
Fillet 
Chamfer 
Offset 
Divide 
Measure 
Change 
Pedit 
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ERASE 

 
The erase command deletes the objects you select from the drawing. Any of the object 

selection methods can be used to highlight the object to erase. The only other required 
action is press Enter to cause the erase to take effect. 

 
Methods for invoking the ERASE command include: 
 

 Toolbar  :   
 Pull-down Menu :  Modify > Erase 
 Command  :  Erase 
 

An example of the erase command prompt is as follows: 
 
 Command: Erase 
 Select Objects: PICK (Use any object selection method.) 
 Select Objects: PICK (Continue to select desired objects) 

Select objects: Enter (Confirm the object selection process and causes Erase 
to take effect. ) 

 Command: 
 

If objects are erased accidentally, U or Undo command can be used immediately following 
the mistake to undo one step, or oops can be used to bring back into the drawing 
whatever was erased the last time erase was used. 
 
 

MOVE 
 

Move allows you to relocate one or more objects from the existing position in the 
drawing to any other position you specify. After selecting the objects to move, you must 
specify the base point and second point of displacement. 

 
Methods for invoking the MOVE command include: 
 

 Toolbar  :   
 Pull-down menu :  Modify > Move 
 Command  :  Move 
 
The prompts for the MOVE command are as follows: 
 
Command: move 
Select objects: ( Select objects you want to move ) 
Select objects: ( Press ENTER ) 
Base point or displacement: ( Select a point ) 
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Second point of displacement: ( Select a point ) 
 
Example  
In the following figure, you want to put a corner of the rectangle at the center of the 
circle. 
 
Command: move 
Select objects: 1 found ( select the rectangle ) 
Select objects: ( Press ENTER ) 
Base point or displacement: end of  ( Select the corner of the rectangle ) 
Second point of displacement: center of ( Select any point on the circle 
circumference ) 
Command:  

 
Figure 1 : Using MOVE Command to put the rectangle at the center of the circle 
 

ROTATE 
 

Selected object can be rotated to any position with this command. After selecting 
object to rotate, you select a “basepoint” ( a point to rotate about ) then specify an 
angle for rotation. 
 
Methods for invoking the ROTATE  command include: 
 

 Toolbar  :   
 Pull-down menu :  Modify>rotate 
 Command  :  Rotate 
 
An example of the ROTATE command prompt is as follows: 
 Command: rotate 
 Select Object: ( Specify the objects to rotate ) 
 Base Point : end of ( Specify the basepoint ) 
 < Rotation angle>/Reference: 
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Figure 2: Using the ROTATE command to rotate the rectangle about 900 from 

basepoint 
 

TRIM 
 

The Trim command allows you to trim ( shorten ) the end of end object back 
to the intersection of another object ( figure ). The middle section of an object can 
also be trimmed between two intersection objects. There are two steps to this 
command; 
 

1. PICK one or more “cutting edge” ( existing object ) 
2. Then PICK the object or objects to trim ( portion to remove ) 
 

The cutting edges are highlighted after selection. Cutting edges themselves can be 
trimmed if they intersect with other cutting edges, but lose their highlight when 
trimmed. 
 
Methods for invoking the TRIM command include: 
 

Toolbar  :   
Pull-down menu :  MODIFY > TRIM 
Command  : TRIM 

 
 
An example of the erase command prompt is as follows: 
 
Command: trim 
Select cutting edges: ( Projmode = UCS, Edgemode = No Extend) 
Select Objects: PICK ( Select an object to use as a cutting edge ) 
Select Objects: PICK 
Select Objects: Enter 
< Select object to trim >/Project/Edge/Undo:PICK ( select the end of and object to 
trim ) 
< Select object to trim >/Project/Edge/Undo: PICK 
< Select object to trim >/Project/Edge/Undo:Enter 
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Command: 
 

 
 

Figure 3: Using TRIM command to trim the objects. 
 
 
 
 
SCALE 
 
The scale command is used to increase or decrease the size of objects in a drawing. The 
scale command does not normally have any relation to plotting a drawing to scale. 
 

Methods for invoking the SCALE command include: 

Toolbar  :   
Pull-down menu :  MODIFY > SCALE 
Command   : SCALE 

 
An example of the scale command prompt is as follows: 
 
 Command : scale 
 Select Object : PICK or ( coordinates) ( Select the object to scale ) 
 Select Object : ENTER ( Indicates completion of the object selection ) 
 Base point : PICK or ( coordinates ) ( Select the stationary point) 
 Scale factor <Reference>: PICK or (value) or (coordinates) ( Enter a value for the  

       scale factor or interactively scale the set of object) 
Command :  
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Figure 7 : Using SCALE Command to enlarge the rectangle with scale factor;2 
 
MIRROR 
 
This command creates a mirror image of selected existing objects. You can retain or delete 
the original objects ( ‘old object’ ). After selecting objects, you create two points specifying 
a ‘rubberband line’, or ‘mirror line’, about which to mirror. 
 

Methods for invoking the MIRROR command include: 

 Toolbar    :   
 Pull-down menu  : MODIFY > MIRROR 
 Command   : MIRROR  
 
An example of the scale command prompt is as follows: 
 
 Command : mirror 
 Select Object : PICK ( Select object or group of object to mirror ) 
 Select Object : Enter ( Press Enter to indicate completion of object selection. ) 
 First point of mirror line : PICK or (coordinates) (Draw first endpoint of line to  

represent mirror axis by PICKing or entering coordinates) 
Second point of mirror : PICK or (coordinates) (Draw second point of line by PICKing 
or entering coordinates) 
Delete old objects ? <N> Enter or Y ( Press Enter to yield both sets of objects or enter 
Y to keep only the mirrored set.) 
Command : 
 

ARRAY 
 

The array command creates either a Rectangular or Polar ( circular ) pattern of 
existing object that you select. The pattern could be created from a single or from a group 
of objects. Array copies a duplicate set of objects for each ‘item’ in the array. 

 
Methods for invoking the ARRAY command include: 
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Toolbar  :    
  Pull-down menu : MODIFY > ARRAY 

 Command : Array 
 
Rectangular 
This option creates an Array of the selection set in a pattern composed of rows and 
columns. The command syntax for a rectangular is given next: 
 
 Command : Array 
 Select Objects : PICK ( Select object to be arrayed ) 
 Select Objects : Enter ( Indicates completion of object selection) 
 Rectangular or Polar array (<R>/P) : R (indicates rectangular ) 
 Number of rows (---)<1> : (value) ( enter value for number of rows) 
 Number of columns (lll)<1> : (value) (enter value for number of columns) 
 Unit cell or distance between rows (---): ( value) ( enter a value for the  

distance from any of one object to the same point on an object in the 
adjacent  

row. 
Distance between columns (lll) : (value ) (enter a value for the distance from 
any point on one object to the same point on an object in the adjacent 
column. 
Command :  

 

 
 

 
Figure 8: Using Array with Rectangular option 

 
Polar 
This option creates a circular pattern of the selection set with any number of copies 
or ‘items’. The number of item specified includes the original selection set. You also 
specify the center of the array, angle to generate the array through and orientation 
of ‘item’.  
 
 Command  : Array 

Select Object : PICK ( select object to be arrayed) 

s 
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Select Object : Enter  
Rectangular or Polar array ( <R>/P ) : P (indicates Polar array) 
Center point of array : PICK ( select point from array to be generated 

around) 
Number of items : ( value ) ( enter value for number of copies including  
original selection set ) 
Angle to fill (+=ccw,-=cw) <360>: Enter or (value) (press enter for full circular 
array, enter value for less than 360 degree array; enter negative value for 
clockwise generation array) 
Rotate object as they are copied? <Y> Enter or N (Press Enter for rotation of 
copies object about center, N for keeping objects in original orientation.) 

  
 

 
 

Figure 9 : Using ARRAY Command  with polar option 
 

STRETCH 
 
Object can be made longer or shorter with STRETCH. When ‘Stretched’,Line and Plines 
become longer or shorter and Arc change radius to become longer or shorter. Circle do 
not stretch; rather, they move if the circle is selected within the Crossing Window. 
 

Methods for invoking the STRETCH command include: 
 

 Toolbar   :   
 Pull-down menu  : MODIFY > STRETCH 
 Command    :  STRETCH  
 
An example of the stretch command prompt is as follows: 
 
 Command  : STRETCH 
 Select Object(s) : to stretch by crossing-window or polygon 
 Select Object : 
 First Corner : PICK 
 Other Corner : PICK 
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 Select Object : Enter 
 Base point or displacement :  PICK or (coordinates ) ( Select a point to use as the  

point to stretch from. )  
Second point of displacement : PICK or (coordinates) (Select a point to use as the  

  point to stretch to) 
 Command  :   
 
            
  
 
 
 
  
  

 
 
Figure 10 : Stretching the drawing 

 
EXTEND 
 

Extend can be thought of as the opposite of Trim. Objects such as Lines, Arc, and 
Pline can be extended until intersecting another object called a ‘boundary edge’ as in 
Figure 5.18. The command first requires selection of existing object to serve as ‘boundary 
edge(s)’, which become highlighted, then the objects to extend are selected. Objects 
extend until, and only if, they eventually intersects ‘boundary edge’. An Extended object 
acquires a new endpoint at the boundary edge intersection. 

 
Methods for invoking the EXTEND command include: 

Toolbar   :   
  Pull-down menu : MODIFY > EXTEND 
  Command    :  Extend 

 
 Command : extend 
 Select boundary edges : (Projmode = UCS, Edgemode = No extend ) 
 Select Objects : PICK 
 Select Objects : PICK 

Select Objects : Enter  
<Select object to extend>/Project/Edge/Undo: PICK ( Select object to 
extend) 
<Select object to extend>/Project/Edge/Undo: PICK  
<Select object to extend>/Project/Edge/Undo: Enter 
Command : 
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Figure 18 
 
 
 Edge mode/Project mode 
 The edge mode and Project mode switches operate identically to their function with  

the Trim command. Use Edge mode with the Extend option if you want a boundary  
edge object to be imaginarily extended. 
 
 
 
 
 
 
 
    

 
 
 

Figure 19 
 

FILLET 
 

The fillet command automatically rounds a sharp corner ( intersection of two Lines, 
Arcs, Circles, or Pline vertices ) with a radius. You only specify the radius and select the 
objects to be filleted. The objects to fillet do not have to completely intersect but can 
overlap. You can specify whether or not the object are automatically extended or trimmed 
as necessary ( Figure 5.20 ) 

 
Methods for invoking the FILLET command include: 

Toolbar   :     
  Pull-down menu  : MODIFY > FILLET 
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  Command    :  Fillet 
 
 

The fillet command is used first to input the desired radius ( if other than the default 0.500 
value ) and a second time to select the object to fillet. 

 
 Command: fillet 
 ( TRIM Mode ) Current fillet radius = 0.5000 
 Polyline/Radius/Trim/<Select first object>: r ( Indicates the radius option ) 

Enter fillet radius < 0.5000>: ( value ) or PICK ( Enter a value for the desired 
fillet radius or select two points to interactively specify the radius ) 

 Command: 
 

 
 
 
 
 
 
 
 

Figure 20 
    

CHAMFER 
 

Chamfer is a manufacturing process used to replace a sharp corner with an angled 
surface. In AutoCAD, Chamfer is commonly used to change the intersection of two Lines or 
Plines by adding an angled line. The Chamfer command is similar to fillet, but rather than 
rounding with a radius or “fillet”, an angled line is automatically drawn at the distances         
( from the existing corner ) that you specify. 

 
Methods for invoking the CHAMFER command include: 

Toolbar   :   
  Pull-down menu  :   MODIFY > CHAMFER 
  Command   :   Chamfer 
 
 Chamfer can be created by two methods: Distance ( specify two distances ) or 
Angle ( Specify a distance and an angle ). 

 
Distance option  is used to specify the two values applied to create the chamfer. The 
value indicate the distances from the corner ( intersection of the two line ) to each chamfer 
endpoint ( Figure  21 ). Use the chamfer command once to specify distances and again to 
draw the chamfer. 
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Command: chamfer 
(TRIM Mode ) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 
Polyline/Distance/Angle/Trim/Method/<Select first line>:d ( Indicates the distance 
option ) 
Enter first chamfer distance<0.0000>: ( value ) or PICK 
Enter second chamfer distance <value of first distance>: Enter or PICK 
Command: 
 

 
 
 

 
 
 
 
 
 
 
 
 

Fi          Figure 21 
 

OFFSET 
 
Offset creates a parallel copy of selected object. Selected object can be Lines, Arcs, 
Circles, Plines or other objects. Two options are available with offset; offset a specified 
distance and offset through a specified point.  

 
Methods for invoking the OFFSET command include: 

Toolbar   :   
  Pull-down menu  : MODIFY > OFFSET 
  Command    :  Offset 

 
 

 
 
 
 
 
 
 

Figure 22 
 
 

 
 

FIRST 
DISTANCE 

SECOND 
DISTANCE 

Using Distance 
method 

Using Angle 
Method 
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DIVIDE 
 
DIVIDE marks off a specified number of equal lengths on a selected object by placing point 
objects or blocks along the length or perimeter of the object. Valid objects that can be 
divided include arcs, circles, ellipses and elliptical arcs, polylines, and splines. 

 
Methods for invoking the DIVIDE command include: 

  Pull-down menu  : DRAW > POINT>DIVIDE 
  Command    :  Divide 

 
1 From the Draw menu, choose Point  Divide. 
2 Select a line, arc, spline, circle, ellipse, or polyline. 
3 Enter the number of intervals you want to represent. 
 
AutoCAD places a point at each interval on the object. 
 
The point objects that are added to the object can be used for subsequent 

construction by allowing you to OSNAP to equally spaced intervals ( Nodes ). After using the 
Divide Command, the point objects may not be visible

 

 unless the point style is changed with 
the Point Style… dialog box ( Format pull-down menu ). A Regen must be invoked before 
the new Point style will be displayed. Figure 23 below shows Points displayed at the object. 

 
 
 
 
 
 

Figure 23 
 

MEASURE 
 

The Measure command will take an entity such as a line or arc and the 
measurement along it depends on the length of the segment. It similar with divide 
command, accomplishes this by placing a point entity at a specified distance given 
in the measure command. 

 
Methods for invoking the MEASURE command include: 
 

  Pull-down menu  : DRAW > POINT>MEASURE 
  Command   :  Measure 
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Figure 24 Using Measure to divide and measure the line with 3.0 inches length. 
 
CHANGE 
 

Using the change command allows the characteristics of an entity to be 
modified. The Change command allows changing three options: Points, Properties 
or Text 

 
Methods for invoking the CHANGE command : 

 
  Command    :  Change 

 
 

 
 
 
 
 
 
 
 
 

 
 
 
 

Figure 23 : Using Change Command with changing point method 
  

This point allows changing the endpoint of an object or endpoints of several objects 
to one position: 

  Command: Change 
  Select Objects :PICK 
  Select Object :Enter 

Properties/<Change point>:PICK ( Select a point to establish as new 
endpoint of all objects) 

 
PEDIT 

This command provides numerous options for editing polylines ( Plines ). The list of 
options below emphasizes the great flexibility possible with polylines. The first step 
after invoking Pedit is to select Pline to edit. 
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Methods for invoking the PEDIT command include: 

 Toolbar   :    
 Pull-down menu  :  MODIFY > Object > Polyline 
 Command   :  Pedit. 
 
An example of the Pedit command prompt is as follows: 
 
 Command  : Pedit 
 Select Polyline : PICK (select the polyline for subsequent editing ) 
 Close or Open/ Join/Width/Edit Vertex/Fit/Spline/Decurve/Ltype  

gen/Undo/eXit<X>: (option) ( Select the desired option from the screen  
menu or enter the capitalized letter for the desired option. 

 
Close  
Close connect the last segment with the first segment of an existing ‘open’ Pline, 
resulting in a ‘closed’ Pline. (Figure 5.24 ). A closed Pline is one continuous object 
having no specific start or endpoint, as opposed to one closed by PICKing points. A 
closed Pline reacts differently to the Spline option and to some commands such as 
Fillet, Pline option. 
 

 
 
 
 
 

Figure 24 
 
Open 
Open removes the closing segment if the Close option was used previously. ( Figure 
24 ) 
 
Join 
This option join, or connect, any Pline, Lines, or Arc that have exact matching 
endpoint and add them to the selected Pline ( Figure 25 ) Previously closed Plines 
cannot be joined. 
 
 
 
 
 
 

 
 

Figure 25 
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Width 
Width allows specification of a uniform width for Pline segment. ( Figure 26 ).  Non-
uniform width can be specified with the Edit Vertex option. 
 
 
 
 
 
 
 
 

 
 
 

Figure 26 
 
 
Another methods that available under Pedit Command are Edit vertex, fit, 
Spline,Decurve, Ltype gen, Undo and Exit. Please practice that methods 
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